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Part 1. Description
The FW102C is a high-precision, motor-driven filter
wheel used for a host of applications, including color
CCD photography, fluorescence microscopy, and
photometry.
The unit consists of a control unit, a filter wheel housing,
and a removable Ø4" filter wheel. The filter wheel
accommodates up to six Ø1" filters or optics. Filter
selection can be made manually from the push button
controls on the display panel or remotely from a USB 2.0
interface, a serial port, or a TTL level active low (BNC)
input. The FW102C contains an active display to
indicate the selected filter and two separate aperture
openings at the top of unit and at 210° degrees (See
Figure Figure 8 on page 15).

Features
•
•
•
•
•
•
•
•

Automated Computer Control
Capability (Application Software
Provided)
Holds Six Ø1" Filters
External Trigger In (Increment
Control)
External Trigger Out (Provisioned
from Software)
Bidirectional Controls
700 ms Typical Access Time
Selectable Aperture Openings at 0°
and 210°
Dimmable Display

The FW102C is designed to ensure an accuracy of greater than ±1°. The FW102C easily mounts to our
lens tube systems and optical instruments via two SM1 (1.035"-40) threaded mounts. Adapters are
available to interface to other popular camera, microscope, and telescope thread sizes. The filter wheel is
also compatible with Thorlabs’ 30 mm cage systems, each port has the required four 4-40 tapped holes
to mount the cage rods. The FW102C also features #8 and M6 tapped holes for mounting to steel posts.
Two 1/4"-20 and M6 tapped holes allow the filter wheel to be mounted to a plate. The flexible mounting
system makes the FW102C ideal for both instrument and laboratory applications.
The device comes with a CD-ROM that contains a WindowsTM1-based, standalone application program.
In addition, an OCX is provided to allow easy integrated instrumentation software development. Sample
code is provided for LabVIEWTM2 and C++ code development. The filter wheel can also be controlled
via a set of command line prompts using terminal server software, allowing users to create scripts in
their own programs.
The unit is powered via a 12 VDC input (converter supplied with unit).
New Design
The FW102C features a new, more robust design compaired to the older FW102B. The filter wheel is
turned using a powerful and reliable stepper motor and worm gear. This design will provide millions of
wheel changes over its life time.

Due to play in the gears, some noise can be heard during operation and when
moving or shaking the device. There are virtually no small parts that can come loose
inside the device. This noise is normal and not indicative of a problem.

1
2

WindowsTM is a registered trademark of Microsoft Corporation.
LabVIEWTM is a registered trademark of National Instruments Corporation.
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Shipping Inventory
The FW102C is shipped with the following:
Quantity

Description

1
1
1
1
1
2
6

Controller with Filter Housing
FW102C Filter Wheel
12 Volt DC Converter
Power Cord
USB Cable
SM1CP2 End Caps
SM1RR Retaining Rings

Figure 1
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Part 2. Basic Operation
The following sections describe the basic operation of the motorized filter wheel and application
software.

2.1. Changing and Removing Filters
WARNING
Prior to changing filters, ensure that the power is off and the unit is disconnected from the
DC source.
The filters can be changed by first removing the filter wheel cover, which is held in place with a single
thumbscrew. Filters can then be inserted into the desired locations. The filters are secured to the wheel
via SM1RR-1CT retaining rings, which are included with the unit. For easy access, the entire filter
wheel can be lifted out of the filter wheel housing. Please note that the rear edge of the threaded filter
holes contain a retaining lip that secures one edge of a Ø1" filter. Some filters with a Ø25 mm may need
to be mounted between two SM1RR-1CT retaining rings.
When replacing the filter wheel in the housing, slip the wheel over the shaft and turn slightly to allow
the gears to mesh. Replace the cover and tighten the thumb screw. It is not necessary to return the wheel
to any particular orientation, since the unit will reorient automatically when the power is turned on.

2.2. Mounting
The base of the unit contains an array of mounting holes for attaching to steel posts or directly to other
mounting plates. See the figure below for hole sizes and locations:
2X M6 X 1.0" - 6H

0.319" (8.10 mm)

M4 X 0.7" - 6H

0.312" (7.92 mm)

(3.18 mm)
0.13"
(25.40 mm)
1.00"

8-32 UNC

0.328" (8.33 mm)

(25.40 mm)
1.00"
2 X 1/4"-20 UNC

0.312" (7.92 mm)
(50.80 mm)
2.00"

Figure 2

Filter Wheel Mounting Holes

The filter wheel cover contains SM1 threads for attaching lens tubes or for mounting the unit directly to
cameras, microscopes, and telescopes. The filter wheel can be attached directly to Thorlabs’ 30 mm
cage systems via four 4-40 tapped holes that surround each port.

2.3. Power
The unit comes with an AC wall adapter to supply 12 VDC to the unit. Plug the 2.1 mm plug from the
AC adapter into the DC input jack on the unit. The ON/OFF (0/1) switch is located on the side of the
20242-D02 Rev C, June 17, 2011
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unit. Upon power up, the unit will display the filter number that is located at the selected aperture. If the
wheel is not located at a valid location, it will rotate to the closest valid position.

2.4. Aperture
The unit has two aperture locations labeled “A” and “B” for the 0° and 210° positions, respectively (see
Figure 3 below). The A/B switch on the side of the unit selects the aperture.
SM1 (Ø1.035"-40)
Thread 0.15" Deep
2 Places Both Sides
0°

(29.46 mm)
1.16"

(25.52 mm)
1.00"

210°

(14.73 mm)
0.58"

Figure 3

Filter Wheel Apertures

2.5. Manual Control
Pushing the ▲ / ▼ arrow buttons on the top of the unit will adjust the filter location. The arrows
indicate the direction of the wheel’s rotation, and the display will indicate the filter selection. The
display brightness can be adjusted using a small screwdriver at the hole marked DIM.

2.6. External Trigger
The unit may be remotely triggered to advance to the next position. This is done by applying an active
low pulse to the BNC trigger input. The input is TTL compatible and should not exceed 5 V. Because
the input is internally pulled up, the trigger will operate with a passive connection to ground. The trigger
mode defaults on power up to an input mode. Software provisioning can, however, change the trigger
mode to an output mode. In the output mode, the unit generates an active high 10 ms pulse (TTL level)
to indicate that the wheel has completed its rotation to the selected position. This pulse may be used to
activate other equipment. The trigger can be changed to the output mode from the application software
or by sending the command “Trig=1” over the USB interface.
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P
Part 3. Softwarre Contrrol
3
3.1. App
plication Software
S
e Operatio
on
T
The FW102C
C comes witth a CD-RO
OM that conttains applicaation softwarre to control the unit ussing USB
22.0, or RS23
32, from a PC.
P After insstalling the software,
s
appply power too the unit. C
Connect a USB cable
bbetween thee FW102C
C and a PC.
P
To ex
xecute the FW102C standalone applicationn, select
P
Programs > Thorlabs > FW102C fro
om the Startt menu.
T
The initial sccreen will ap
ppear as show
wn below:

Figure 4

Software Screen
S
Shot:: Initial Startu
up Screen

E
Establishiing Comm
munication
ns with FW
W102C
T
To operate th
he filter wheeel, you must first establish a connecction with thhe FW102C. The FW1022C uses a
U
USB driver that
t emulatees a serial po
ort and, when
n installed, w
will add a neew COM poort to the PC
C. Use the
O
Options > Seerial Connecction > Com
m Port menu to select thee new COM port.

Figure 5

Software Screen
S
Shot:: Setting the COM Port

A
After selectin
ng the propeer COM portt, select “Open Connectiion” from thee File Menu
u.
220242-D02 Rev
v C, June 17, 2011
2
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T
The unit is now
n ready to
o operate eith
her from the application software orr from the froont panel coontrols on
tthe unit. Thee “Save Optio
ons” menu item will sav
ve the selecteed options foor future sessions.
F
Filter Positio
ons can be ch
hanged in an
ny of the folllowing wayss:
•

Pushiing the ▲ / ▼ buttons on
o the top off the unit

•

Dragging the slid
de bar to the desired posiition

•

g the increm
ment / decrem
ment arrows in
i the positioon window
Using

Figure
F
6

So
oftware Scre
een Shot: Ch
hanging the F
Filter Positio
on

P
Programm
med Seque
ence Operation (Sc
can Mode))
T
The applicattion softwarre also conttains the caapability to control the filter wheeel in a proggrammed
ssequence.
T
To operate in this mod
de, enter th
he filter num
mber(s) of the desiredd sequence into the PO
OSITION
SSEQUENCE
E box. A com
mma should separate eacch entry (Seee Figure 6 abbove). The T
TIME (SEC)) box sets
tthe delay bettween filter changes.
c
T
The program
mmed sequen
nce may be set to run a single evenn or to run inn a continuoous mode. T
To choose
tthe sequencee mode, selecct Options > Scan Modee. Begin the ssequence byy clicking onn the RUN buutton.

H
Help Menu
u
T
The Help menu
m
contains a synopsiss of the com
mmand line language foor those whoo need to geenerate a
sscripting pro
ogram to con
ntrol the FW102C.

M
Minimum PC Requirements
T
The applicattion program
m requires a minimum of
o a Pentium
m-class machhine runningg Windows 998, 2000,
N
NT, XP, Vistta, or Windo
ows 7.
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v C, June 17, 2011
2

Page 9

www.thorlabs.com

Motorized Filter Wheel

3.2. Command Line Interface
The FW102C can also be controlled by a command line language through the USB or RS232 ports. This
is offered to enable operation through a terminal interface or for those who may want to write their own
program to control the wheel. Prior to running the command line interface, the unit should be powered,
and a USB or RS232 cable should be connected between the FW102C and the host. The terminal
emulator should be configured as follows:
Parameter

Setting

Baud Rate
Data Bits
Parity
Stop Bits
Flow Control

115.2K Bits Per Second
8
None
1
None

If the connection is correct, you will see the following message after pushing the Enter key:
Command error CMD_NOT_DEFINED
This message will be followed immediately by the prompt:
>
The basic structure of the interface is a keyword followed by either an equals sign “=” or a question
mark “?”. The “=” or “?” will determine if the string is a command or a query. All strings (commands
and queries) must be terminated by a carriage return (CR) or pressing the ENTER key on the computer.
Command Structure
Keyword = argument (CR)
Here, keyword defines the function, and argument is a numerical value followed by a carriage return
(CR).
Query Structure
Keyword? (CR)
Keyword defines the function, and the question mark (?) indicates a query. The string is terminated with
a carriage return (CR). Exceptions to this and unique shortcut keys are given in the table on page xxx.
The prompt symbol “>” will appear on power-up and after a command is accepted by the FW102C and
indicates that the FW102C is ready to receive another command line.

Keywords (Commands and Queries)
The following table describes all of the available commands and queries:
20242-D02 Rev C, June 17, 2011
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Command

Syntax3

Description

Get ID
Set Position
Set Position Count
Get Position Count

*idn?
pos=n
pcount=n
pcount=?
trig=0
trig=1
Trig?
speed=0
speed=1
speed?
sensors=0
sensors=1
sensors?
baud=0
baud=1
baud?
save

Returns the model number and firmware version
Moves the wheel to filter position n
Sets the wheel type where n is 6 or 12
Returns the wheel type
Sets the external trigger to the input mode
Sets the external trigger to the output mode
Returns the trigger mode
Sets the move profile to slow speed
Sets the move profile to high speed
Returns the move profile mode
Sensors turn off when wheel is idle to eliminate stray light
Sensors remain active
Returns the sensor mode
Sets the baud rate to 9600
Sets the baud rate to 115200
Returns the baud rate where 0 = 9600 and 1 = 115200
This will save all the settings as default on power up

Set Trigger Mode
Get Trigger Mode
Set Speed Mode
Get Speed Mode
Set Sensor Mode
Get Sensor Mode
Set Baud Rate
Get Baud Rate
Save Settings

If the keyword, format, or argument are incorrect or out of range, the unit will return an error string.
In addition to the commands given above, there is also special functionality added to the arrow keys of
the computer’s keyboard:
Key
Up Arrow
Down Arrow

Description
Increments the filter position by 1
Decrements the filter position by 1

3.3. ActiveX Control
An ActiveX control, FW102.ocx, is installed with the software. This feature can also be used to control
the wheel from an environment that supports ActiveX. The methods and properties supported by the
ActiveX control are described below:

3

All Commands and queries are in lower case letters.

20242-D02 Rev C, June 17, 2011
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Methods
AboutBox
SelectComPort
SelectBaudRate
ShowDialog
OpenPort
ClosePort
IncrementPosition
DecrementPosition
SaveCalibrationData
GetCommands

Properties
ID
ComPort
BaudRate
PortOpen
Position
MaxVelocity
Acceleration
PositionCount
SensorsAlwaysOn
TriggerType
MinVelocity
CalibrationPassword
ElapsedTime
StatusWord
SpeedProfile

20242-D02 Rev C, June 17, 2011

Description
Displays a dialog box with information about Thorlabs
Displays a dialog box to select the com port that the filter wheel is connected to
Displays a dialog box to select the desired baud rate for communications
Displays a dialog box to control the filter wheel
Opens the com port
Closes the com port
Advances the wheel one position clockwise
Advances the wheel one position counterclockwise
Saves the current motor parameters
Lists the available commands

Description
Gets the product name and firmware version of the filter wheel
Sets/Gets the com port for communications with the filter wheel
Sets/Gets the baud rate for communications with the filter wheel
Gets the status of the com port
Gets/Sets the current filter position
Gets/Sets the maximum velocity
Gets/Sets the acceleration rate
Gets/Sets the number of filter position in the wheel
Gets/Sets a flag to indicate if optical sensors should remain on after move
Gets/Sets trigger mode to input or output
Gets/Sets the minimum velocity
Sets the calibration password for saving motor parameters
Gets the time last move took in milliseconds
Gets the result of the last move
Gets/Sets the current speed profile

Page 12
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P
Part 4. Trouble
eshootin
ng and Maintena
M
ance
D
Dust or debrris can someetimes set intto the filter wheel housiing and blocck the sensorrs. This willl result in
tthe filter wh
heel failing to
t move to the
t desired position.
p
Too prevent thiis, periodicaally remove the filter
w
wheel and usse compresseed air to cleaar away any contaminannts.

R
Removing
g Filter Ho
older
T
The filter ho
older maybe tight and difficult
d
to reemove. To m
make the whheel release with the miinimal of
fforce, grab itt on the righ
ht side (by fillter position 5 in image bbelow) and pull the wheeel out and tto the left
aas depicted by
b the large red
r arrow.
W
When reinseerting the wheel,
w
push the filter ho
older onto tthe post jigggling the holder clockw
wise and
ccounterclock
kwise to help
p align the geears.
Fillter Holder

Figure 7

220242-D02 Rev
v C, June 17, 2011
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Part 5. Specifications
5.1. Performance
Parameter

Min

Typical

Max

Access Time
(Adjacent Locations)
Access Time (Other Locations)

-

900 ms

-

-

2500 ms

-

Accuracy/Repeatability

-

±0.5°

±1°

1.5 x 10

-

-

Min

Typical

Max

-

-

0.5 pulses/sec

1.0 ms

-

-

Input High

3.3 V

4.5 V

5.3 V

Input Low

0.3 V

0.0 V

1.0 V

6

Expected Cycles

5.2. Electrical
Parameter
BNC Input Trigger
Max Rate
Minimum Pulse Width
4

BNC Input Trigger

BNC Output Trigger
Output Pulse Width

9.0 ms

10.0 ms

11.0 ms

5

2.5 V (1 KΩ)

3.3 V (1.95 KΩ)

5.0 V (Hi Z)

4

0.0 V

0.0 V

1.0 V

Power (DC Input, 1 A)

11.75 VDC

12 VDC

12.25 VDC

Operating Temperature

0 °C

-

60 °C

Output High
Output Low

5.3. Physical Characteristics and Interface
Parameter

Description

Trigger Jack

BNC Female

Power Jack

Male 2.1 MM

USB Connector
Mounting

Mini B
(2) 1/4"-20, 8-32, (2) M6, M4, (2) SM1 Thread

Filter Diameter

1" (25.4 mm)

Max Planar Filter Width
Dimensions (L x W x H)
Weight (Without Power Supply)

0.25" (6.35 mm)
5.44" x 1.85" x 4.39"
(138 mm x 47 mm x 112 mm)
1.65 lbs. (0.75 kg)

4

The BNC input trigger is an active low input. The input has an internal 1 KΩ input resistor. Grounding the center conductor
of the jack will activate the trigger.
5
When operating as an output, the unit output driver is configured in series with a 1 KΩ resistor.
20242-D02 Rev C, June 17, 2011
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Part 6. Mechanical Drawings
Front

SM1 (Ø1.035"-40)
Thread 0.15" Deep
2 Places Both Sides

8 X4-40 UNC 0.100" (2.54 mm)
For 30 mm Cage Plate

Side

(135.41 mm)
5.33"

(Ø56.36 mm)
Ø2.22"

(29.46 mm)
1.16"
In/Out Trigger
(25.52 mm)
1.00"

Serial Port
(90.39 mm)
3.56"
USB Port

(70.14 mm)
2.76"

Power

(14.73 mm)
0.58"

(130.78 mm)
5.15"

Bottom

2X M6 X 1.0" - 6H

0.319" (8.10 mm)

(50 mm)
1.97"
(25 mm)
0.98"

M4 X 0.7" - 6H

0.312" (7.92 mm)

(10.80 mm)
0.43"

(25 mm)
0.98"
(18.67 mm)
0.74"

(3.18 mm)
0.13"
(25.40 mm)
1.00"

8-32 UNC

(15.56 mm)
0.61"
(31.12 mm)
1.23"

0.328" (8.33 mm)

(25.40 mm)
1.00"
2X 1/4"-20 UNC

0.312" (7.92 mm)
(50.80 mm)
2.00"

Figure 8
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P
Part 7. Regulattory
A
As required by the WE
EEE (Waste Electrical and Electroonic Equipm
ment Directivve) of the E
European
C
Community and the corrresponding national
n
laws, Thorlabs offers all ennd users in thhe EC the possibility
tto return “en
nd of life” un
nits without incurring
i
dissposal charg es.
•
•
•
•
•
•

This offer is valid
d for Thorlab
bs electrical and electronnic equipment:
Sold after Augustt 13, 2005
Mark
ked correspondingly with
h the crossed
d out “wheellie bin” logoo (see right)
Sold to a compan
ny or institutte within the EC
Curreently owned by a compaany or institu
ute within thee EC
Still complete,
c
no
ot disassemb
bled and not contaminateed
Wheelie Bin
n Logo

A
As the WEE
EE directive applies to seelf-contained
d operationaal electrical aand electronnic products,, this end
oof life take back
b
service does not refe
fer to other Thorlabs
T
prodducts, such aas:
•
•
•
•

Pure OEM produ
ucts, that meeans assemb
blies to be buuilt into a uunit by the uuser (e. g. OE
EM laser
driver cards)
Comp
ponents
Mech
hanics and op
ptics
Left over
o
parts off units disasssembled by the
t user (PC
CB’s, housinggs etc.).

IIf you wish to
t return a Thorlabs
T
uniit for waste recovery,
r
please contactt Thorlabs oor your neareest dealer
ffor further in
nformation.

7
7.1. Was
ste Treatm
ment is Your
Y
Own
n Respon
nsibility
IIf you do nott return an “eend of life” unit
u to Thorllabs, you muust hand it too a companyy specializedd in waste
rrecovery. Do
o not disposee of the unit in a litter bin
n or at a pubblic waste disposal site.

7
7.2. Eco
ological Backgrou
B
nd
IIt is well kno
own that WE
EEE pollutess the environ
nment by relleasing toxicc products duuring decom
mposition.
T
The aim of the Europeaan RoHS diirective is to reduce thhe content oof toxic subsstances in eelectronic
pproducts in th
he future.
T
The intent off the WEEE directive is to enforce the
t recyclingg of WEEE. A controlled recycling of end of
llife products will thereby
y avoid negaative impactss on the enviironment.
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Part 8. Thorlabs Worldwide Contacts
USA, Canada, and South America
Thorlabs, Inc.
435 Route 206
Newton, NJ 07860
USA
Tel: 973-579-7227
Fax: 973-300-3600
www.thorlabs.com
email: feedback@thorlabs.com
Europe
Thorlabs GmbH
Hans-Böckler-Str. 6
85221 Dachau
Germany
Tel: +49-(0)8131-5956-0
Fax: +49-(0)8131-5956-99
www.thorlabs.de
email: Europe@thorlabs.com

UK and Ireland
Thorlabs LTD.
1 Saint Thomas Place, Ely
Cambridgeshire CB7 4EX
Great Britain
Tel: +44 (0)1353-654440
Fax: +44 (0)1353-654444
www.thorlabs.de
email: sales.uk@thorlabs.com

France
Thorlabs SAS
109, rue des Côtes
78600 Maisons-Laffitte
France
Tel: +33 (0) 970 444 844
Fax: +33 (0) 811 381 748
www.thorlabs.de
email: sales.fr@thorlabs.com

Scandinavia
Thorlabs Sweden AB
Box 141 94
400 20 Göteborg
Sweden
Tel: +46-31-733-30-00
Fax: +46-31-703-40-45
www.thorlabs.de
email: scandinavia@thorlabs.com

Japan
Thorlabs Japan Inc.
Higashi Ikebukuro
Q Building 1st Floor 2-23-2
Toshima-ku, Tokyo 170-0013
Japan
Tel: +81-3-5979-8889
Fax: +81-3-5979-7285
www.thorlabs.jp
email: sales@thorlabs.jp

China
Thorlabs China
Oasis Middlering Centre
3 Building 712 Room
915 Zhen Bei Road
Shanghai
China
Tel: +86 (0)21-32513486
Fax: +86 (0)21-32513480
www.thorlabs.com
email: chinasales@thorlabs.com
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